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Executive Summary

Microsoft Analysis Services includes a powerful database engine that provides rapid access to highly summarized business data. Analysis Services publishes data in the form of a cube, which allows you to easily filter (slice) and group (dice) by predefined categories. A summarized number is called a measure. Each item you group by is called a member. A set of related grouping is called a dimension. Members of a dimension typically form a hierarchy, so that you can drill down from more summarized values to more detailed values. 

A cube is often used with general-purpose browsing tool, which makes it possible for you to interactively explore data in reports. Microsoft Office ships with PivotTable reports, a general-purpose browsing tool that can interact with a cube. PivotTable reports come in two versions, Excel and the Office Web Components (OWC). The Excel PivotTable report is integrated with the standard Excel workbook environment, and the OWC PivotTable is an ActiveX control that can be embedded in a web page or integrated into an application. PivotTable reports are excellent for structured browsing, but are too “rigid” for many reporting applications.

The new Microsoft Excel Add-In for SQL Server Analysis Services fills a gap by providing flexible free-form reports coupled with structured reports. The structured reports are similar in many ways to PivotTable reports, but with some added functionality, most notably the following:

· Reports automatically support advanced Analysis Services capabilities such as actions, what-if analysis, and Drillthrough. 

· Advanced techniques are available for specifying members from a dimension, including wild card searches and data-driven selection

The greatest benefits of the add-in come from free-form reports. Unlike Structured reports, free-form reports do not use structured report segments and a data grid. Rather, individual cell formulas connect each cell to the connection. Row, column, and page cells retrieve dimension member names from the connection. Data cells retrieve values. Report cells no longer need to form a contiguous block. You can insert Microsoft Excel formulas into the middle of the report and rows and columns can be inserted or individual cells moved freely on the worksheet. Following are some of the greatest benefits of a free-form report:

· Mixed hierarchies can be arranged in a single report axis, which makes it easy to create asymmetrical reports. 

· A single report can integrate members and values from multiple connections, including cubes from different servers

The queries generated by the add-in are optimized so that the performance is similar to that of using a PivotTable report.  

Building Basic Reports

A report consists of a connection to a data source, coupled with a layout that organizes the data values. The layout can be structured or free-form. Many aspects of report layout and member selection are the same between structured and free-form reports. To create a structured report, you start with the Layout pane. To create a free-form report, you start with the Data pane. You can convert a structured report into a free-form report, but you cannot convert a free-form report into a structured report.

A report layout consists of four possible regions:

· Row axis

· Column axis

· Page Filter axis

· Data Grid

The row and column axes define the structure of a report. The cells where the axes intersect form the data grid, which is where the summarized numbers appear. Page filters restrict the data that appears in the data grid, but they don’t affect the row and column headers (unless you create custom expressions).  

When you install the Excel Add-In for Analysis Services, a Cube Analysis menu appears on the Excel toolbar. If that menu is not available, you need to install the add-in. When you click Build Report from the Cube Analysis menu, a task pane named Build Report appears. 
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Note: A structured report “owns” its section of the worksheet, so you can’t insert rows or columns or add formulas into the middle of it—much the same as with a PivotTable report. A free-form report contains individual cells, each of which contains a special function—CubeCellMember for the row and header cells, and CubeCellValue for the data grid cells. Because each cell contains an independent function, you can move cells around, insert rows and columns, interleave formulas, or whatever else you want. You don’t need to worry about the functions for a free-form report, because the Report Builder creates them for you, but you are able to enter or modify the add-in functions if you choose. 

Create a Structured Report Layout 

Adding data to reports is very similar for both structured and free-form reports. The biggest difference between the two when creating a report is that with a structured report, you define the layout before you add data. 

In a structured report layout, each axis can have one or more segments. Each segment contains one or more members from a single dimension. A dimension can appear in only one segment. A good way to understand how segments work is to build a report from segments.
· Activate the Build Report task pane and select the Layout pane. The Insert New Report section of the Layout pane contains several templates with pre-defined combinations of segments, but these are only starting points that illustrate common combinations. 
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To create a report layout that shows all the possible segment types, select an appropriate starting cell and then, in the New Report section of the task pane, click the Row, Column, and Page Filters option. Other layouts create simpler structures.

· To add a second page filter, click the Page Filter option of the Insert Segment or Grid section. You can add as many page filters as you want. Each page filter allows you to slice by a member of another dimension.

· To add a second, nested, row header segment, click the Row Header option. Nesting segments on an axis allows you to dice by members of an additional dimension. For each product on the rows axis, you could show the sales for each income level, with columns still showing the months.

· To delete a page filter segment, select one of the page filter cells, and on the Cube Analysis menu, point at the Delete menu, and click Segment. 

To add a segment, you use the Insert Segment portion of the task pane. To remove a segment, you use the Delete submenu on the Cube Analysis menu. You can also remove all the segments on the selected axis by clicking Axis on the Delete menu. You must have an empty segment in order to add structured data to the report.
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Tip: The add-in does allow you to undo a command, but you must make sure your Excel security settings allow it. To do that, on the Tools menu, point at Macro, and click Security. Activate the Trusted Publishers tab, and select the Trust access to Visual Basic Project checkbox. The add-in can undo only one command, but Excel operations allow standard multi-level undo.
Add Data to a Report

Before you can add data to a report, you connect to a data source by opening a connection. A connection defines the Analysis Services server, database, and cube. Once you’ve opened a connection, you can access any of the dimensions available from that connection. 

Data Connections

To open a connection, activate the Data pane. If you’ve already created a connection, you can select the connection from the Connection Name list. If you do not have an existing connection, you must create a new one.

Tip: The connection information is stored in a standard Office Data Connection (.odc) file. Excel and OWC PivotTables also use .odc connection files, so if you have already created a PivotTable report, you may have a connection available.
To create a new connection, click the ellipsis button next to the Connection Name box. Type the Analysis Services server name and click Next. Then select the database and cube from those available on the selected server. The wizard gives a default name to the connection. Replace the name if you want, and then click Finish. The connection is saved as an .odc file in the current user’s Application Data\ORSLN folder.

Explicit Member Selection

With either structured or free-form reports, you can add explicit members of any dimension to the row and column axes, and explicit members of a non-measures dimension to the page filter axis. 

Select a dimension from the Dimension list. In the Display group, select Member Tree, and in the Browse list, select one or more members. If you are adding a page filter, select a single member from a non-measures dimension. The next step depends on whether you’re creating a structured or free-form report:

· If you’re creating a structured report, select any empty segment of an existing report layout. 

· If you’re creating a free-form report, select a blank cell on a worksheet. The add-in will later prompt you for whether you want the members as row headers, as column headers, or (if you selected a single member) as a page filter. 

In either case, click the Apply button or drag one of the selected members onto the segment or cell. When you drag members onto a report, the members appear in the segment or cell where you release the mouse pointer, regardless of the currently selection. With a structured report, data values appear in the report as soon as you add members to a row or column segment.

Tip: When you add row headers to a free-form report, be sure to leave blank rows at the top for adding column headers.  The report builder always creates free-form reports with both column and row headers (although you can create any free-form layout you want by using add-in functions.).

With either structured or free-form reports, you can nest multiple dimensions to a single axis.

· To nest dimensions on a structured report, simply add additional segments to an axis. Then add members to each segment.

· To nest dimensions on a free-form report, simply select a cell to the left or right of existing row headers (or above or below existing column headers) before clicking Apply. (As always, rather than select a cell and clicking apply, you can simply drag the members to the appropriate cell.)

With either structured or free-form reports, you can add measures to the data grid area of the report. There are two approaches to adding measures. 

· If you want to display only one measure, add the measure directly to the data grid. When you add a measure to the data grid, the report does not automatically display the name of the measure you used. You cannot add a measure to the data grid of a free-form report until after you create row and column axes.

· If you want to display multiple measures to the report, or if you want to display the name of the measure, add the measures to a row or column axis, the same as with a non-measures dimension. When you add measures to an axis, the report builder automatically adds values to the grid for both structured and free-form reports.

When you assign a single measure to the data grid, and want to replace it, the process is different between a structured and a free-form report. In a structured report, you can simply drag a different measure to the grid. In a free-form report, you need to delete the formulas from the data grid cells before adding a new measure to the grid.

To replace the members (whether measures or not) that appear in a row, column or page filter segment, you must first empty the segment. To do that, click a single cell in the segment, and then on the Cube Analysis menu, point at Delete, and click Segment Data. There is no concept of replacing row, column or page filter members in a free-form report. In a free-form report, to replace formulas, simply delete the old ones before adding new members to the report.

Tip: In addition to using the Build Report task pane to create a free-form report, you can also create a structured report and then convert it to a free form report. To convert a structured report, select any cell in the report, and then on the Cube Analysis menu, click Convert to Free-Form. (The Convert to Free-Form command also appears on the context menu for cells in a structured report..) 

Extended Member Selection

In addition to adding individual members to the report, you can find members by using extended techniques. There are three extended ways to derive members that can be used with either structured or free-form reports: Family relationships, level members, and member searches. A fourth technique—custom expressions—can be used only with structured reports.
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Family relationships take advantage of the hierarchical relationships definitions defined in a dimension. You can start with one member and then add members related to it. In the Data pane of the Build Report task pane, select one or more members and then select one of the options from the Define Selection Set list. Most of the options are self-explanatory. Leaves are members at the bottom of the hierarchy. They don’t have any children below them. Finding the leaves of a member is particularly useful when you have a dimension that varies in depth, such as an organization chart, or a financial chart of accounts.

· Level members let you select all the members of a level. In the Display group, select the Dimension Level option. Then select a level and add it to the report. The process is the same as adding a member, except that all the members of that level appear on the report.

· [image: image8.png][Yearly Income. $T60K + v[Store__USA o

| SN A I I —

(AT a2 5] o1

[AllProducts [All Education Level 5629 1433 1319 1462 1415
Drink Al Education Level 580 13 149 119 174
[Food =4Il Education Level 4038 1065 883 1085 100§
Bachelors Degree o 242 28 269 201

Graduate Degree 435 88 2 @2 173

High School Degree | 1460 357 278 520 295)

Partial College 219 72 62 E3) 46}

Partial High Schoal 984 296 233 165 20|

Mon-Consumable [All Education Level 1011 230 207 268 23]




[image: image9.png]Build Report

Define Selection Set As:

Mermber(s) only

e
[Member(s) + Chidren
(Chidren of Member(s)
[Member(s) + Descendants
IDescendants of Member(s)
[Member(s) + Siings
Leaves cf Member(s)

on Leaves of Member(s)
| Custom Expression.




A member search allows you to select members based on part of the member name. If you’re looking for a specific invoice number, you can request an exact match. If you’re looking for a sales representative whose name is Smith or Smythe, you can choose names that Start with specific characters. If you’re not sure what you’re looking for, you can search for a match anywhere in the name. 
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A custom expression is a sophisticated selection mechanism that is available in a structured report. To create a custom expression, you select a single member from the Member Tree list, and then, from the Define Selection Set drop-down, select Custom Expression. A simple use is to select only the members of a level that are descendants of a specific member (effectively, the combination of the family relationship and level member mechanisms). A more complex use is to act as a data driven filter for members. If you base the set on the selected member, the results are restricted to descendants of that member. If you base the set on the entire hierarchy, the currently selected member is ignored. You then select the level, a measure, a relationship, and one or more values. You can add multiple conditions. For example, a custom expression can show only high-volume stores that have a low profit margin.

Tip: Custom expressions can create comparisons only against measures. If you want, for example, to filter for departments where the paper-clip account is more than 5% of all expenses, you would need to ask the cube designer to create a calculated measure on the cube that tests the account dimension. 
Most of these techniques work whether you are using structured or free-form reporting. Some of these techniques, however, have special results in a structured report if the data source later changes. If you choose the members of a level, or use a custom expression, then changes to the database will propagate to the report. For example, if the Foodmart 2000 Product dimension changes to include, say Services, as a new Product Family, a report that shows the members of the Product Family level will automatically change to include the new item, while a report with explicit members remains the same as when it was created. A free-form report always uses explicit members, even if the members are originally populated by using an extended member selection technique.

Interact with a Report

Once you have created a report, you can interact with it. The simplest interaction is to select a new member as a page filter. To do that, from the page filter drop-down, select a different member as a filter. 

Structured Report Specifics

In a structured report, to move a segment to a new location in the report—that is, to pivot the segment—drag the plus symbol (+) at the bottom left corner of cell in the segment. You can drag a segment from the row axis to the column axis and vice versa. You can drag a nested segment to a new position on the axis. You can move the page filter anywhere in the region above the body of the structured report. You cannot drag a dimension between the page filter area and a header area. 

· To move the entire report to a new location, drag the caret symbol (^) at the top left corner of any cell. 

· To move a page filter segment to a new location, Drag the plus symbol (+) in a page filter cell. 

Tip: Moving page filters is particularly useful when you have multiple page filters: you can arrange the page filters vertically, horizontally, or in any grid arrangement you want.
In a structured report, you can navigate to new members related to the ones on the row or column header. Select a header member and then choose one of the following options from the Cube Analysis menu’s Navigation submenu:

· Drill Up - Replaces all the members in the segment with the parent of the selected member, along with all its siblings.

· Drill Down – Replaces all the members in the segment with the children of the selected member.
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Expand – Inserts the children of the selected member. If the segment is nested (so that the selected member repeats for each member of the outer segment), expands all instances of the selected member.

· Collapse – Removes the children of the selected member. If the segments is nested (so that the selected member repeats for each member of the outer segment), collapses all instances of the selected member.

· Expand Only – Behaves like Expand except that if the segment is nested, expands only the selected member and not the repeated copies. 
· Collapse Only – Behaves like Collapse except that if the segment is nested, collapses only the selected member and not the repeated copies.
· Isolate - Removes all members other than the selected member from the segment, including all repeated members in a nested segment.

· Eliminate - Removes the selected member from the segment, including all repeated members in a nested segment.

All the navigation commands except Expand Only and Collapse Only also appear on the context menu. Double-clicking a member is the same as executing the Expand or Collapse command. 

Free-Form Specifics

Navigation options for a free-form report are more restrictive than for a structured report. You can use Isolate and Eliminate, and you can also use the Expand Only and Collapse only commands—either by selecting the command from the Cube Analysis menu Navigation submenu, or simply by double-clicking a cell. In fact, in a free-form report, you can add formulas of your own (called custom data) to the data grid, and the formulas will be replicated to any new rows that are created by expanding a member. 

In order to expand, collapse, or copy custom expressions, you must configure the appropriate global options, and also be careful about the report layout.
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On the Cube Analysis menu, click Options, and activate the General tab. In the free-form reports section, select the option Enable Expand-Only and Collapse-Only commands. If you want custom formulas to fill in to the new rows, also select the option When expanding, show custom data. 
· You must also make sure the data values align with the appropriate row and column headers. Any values that are not in the appropriate row or column will be left alone—they will not replicate with the expanding or collapsing rows. In the graphic, cell G4 contains the formula =E4/C4 to calculate the ratio of Q1 to 1997. Cell G4 constitutes custom data that is dependent on Drink, the member in cell A4. If you have the custom data option enabled, the formulas in column G will replicate along with the add-in formulas in columns C and E. Note that the dependent formulas do not have to be contiguous—it’s OK to have blank cells or columns between the member and the dependent formulas.
Tip: The CubeCellValue function uses standard Excel references. It is possible to have a cell point to a different cell than the one you intended. Use the Formula Auditing toolbar to trace dependent cells to makes sure that formulas are pointing to the correct input cells.
Building Advanced Reports
Advanced Layout 

Once you have created a basic report, you often need to refine the layout. The add-in provides several options for controlling the layout of a standard report, and even more options for controlling the layout of a free-form report.
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Integrate Data from Multiple Sources – With a Free-Form report, you can combine data from multiple cubes, or even multiple servers. For example, you can create a financial report with separate columns for Actual, Budget, and Forecast data, with each column coming from a different source. When you add data from a second data source to a report, the add-In will prompt you to define the row, column and page ranges. Of courses, the row headers in the report would need to be the same between the different cubes. 
· Display Member Properties – A cube designer can add attributes called Member Properties to a dimension member. Often member properties give additional information that doesn’t make sense as a data value—for example, the address of a customer. In a free-form report—but not in a structured report—you can display member properties. To do this, on Data pane of the Report Designer, select the Dimension Level display option. If a level has member properties associated with it, a plus sign (+) appears next to the level name. Expand the plus sign to see the member properties for that level. Select the member properties you want to add, and drag or apply the same as you would with the levels. In addition to a column for the members, the add-in creates an extra column for each member property, containing a CubeCellProperty function that returns the member property value.

· Move Totals to the Bottom – By default totals appear above detail values on rows, and to the left of detail values on columns. You can reverse the setting so that totals appear to the bottom or right of the detail. To do that, on the Cube Analysis menu, click Options. On the Format tab, select the appropriate options.

· Suppress Empty – In a structured report, you may want to hide rows or columns where the data cells are all empty. To do this, on the Cube Analysis menu, click Options. On the Data menu, select the Supress Empty Rows or Supress Empty Columns options. This setting applies only to reports on the active sheet. This allows you to show empty rows on one sheet and hide empty rows on another. This setting is not relevant to free-form reports, because free-form reports are always defined with explicit members.
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are typically to the left, and column headers above the data. In some situations, you may want to put row headers to the right of the data. To put row headers to the right of the data, create a report with a single column header segment. Select a cell in the segment, and on the Cube Analysis menu, point at Cut, and click Segment. Then select the right-most cell in the data grid, and on the Cube Analysis menu, click Paste. This pastes the segment on the right side of the data. You can now add additional row header or column header segments. (This technique would also work to put column headers below the data, should you ever have a situation that requires.) This technique is not required In a free-form report, because in a free-form report you can simply cut and paste the relevant cells.

Advanced Formatting

In addition to layout, the ability to precisely control the formatting in a report can be very valuable. The add-in takes advantage of two different but complementary mechanisms for adding formatting to a report: The formatting capabilities inherent in Excel, and formats that are defined on the server by the cube designer.
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Native Excel formatting – Because the add-in operates in Excel’s environment, you are able to apply standard Excel formatting to the cells. Not only can you apply simple cell formatting—such as number formats, but you can apply conditional formatting. With conditional formatting, you can apply a different format based on the contents of the cells. For example, you could change all the cells where the Profit % is greater than 60% to display a green background. You can use Excel formatting in both structured and free-form reports. Incidentally, even though you can apply conditional formats to cells in a PivotTable report, the conditional formatting disappears when you refresh the report.

Tip: When you apply Excel formatting to a measure, apply the format to the entire column so that the formats will apply to cells that become part of the report when you expand a member. 

· Server formatting – A cube designer can assign number formats to measures on the server. If you enable server side number formats, the add-in retrieves the full-precision value of the cell, and also retrieves the defined number format and applies that format to the cell. This allows you to create formulas that do not have rounding errors. In addition, a designer can create server-based conditional formats that look at data more detailed than what you see on the report. For example, cell formatting defined in a cube could make the Profit background color appear red if any of the children of the current member has a low profit percent. To enable server formatting, on the Cube Analysis menu, click Options. Activate the Format tab and select which server formats to apply.

Note: The add-in does not have a mechanism to easily give different formatting to different levels of a hierarchy. For example, you cannot easily make all the Subcategory level rows bold. You can, of course, apply Excel formatting to cells, but the formatting does not shift with the rows when you navigate on the dimension.

Advanced Analytical Features

Analysis Services allows a cube designer to add special interactive capabilities to a cube. The add-in supports any of those capabilities that may be available. 
Actions
Suppose you have a web site that gives detailed information about your company’s products. You may want to be able to jump to the web page for a specific product when you’re looking at that product in a report. An Action makes it possible to do that. The cube designer defines an Action that opens a web page with a URL that includes the current product. 
Note: The add-in supports only action with a URL type. If there are other types of actions defined in the cube, they do not appear on the Actions menu.

Actions work the same in both structured and free-form reports. Once you add cells to the report that have a URL action assigned to them by the cube designer, you simply right-click the cell, point at Actions, and click the appropriate action name. If the Actions menu is disabled, there are no URL actions defined for the selected object.
Drillthrough

Cubes are designed to show aggregated data values. Often the original data source for a cube contains more detail than is stored in the cube itself. For example, a cube that summarizes sales amounts may not contain specific information about order numbers, even though that information is available in the source data. The cube designer can enable Drillthrough for a cube to make it possible for you to retrieve detailed information from the cube’s original data source. 

Drillthrough works in both structured and free-form reports. If you are using a cube that has been enabled for Drillthrough, right-click a single data cell and click Drillthrough. The detailed columns selected by the cube designer appear on a new worksheet.

A highly-summarized data cell can refer to millions of data rows in the Drillthrough data source. To avoid returning millions of data rows to Excel, the add-in allows you to set a limit on the number of rows that Drillthrough will return. By default, the limit is set to 100 rows, but you can change the limit, or remove it entirely. Remember, however, that an Excel worksheet has on 65,536 rows. To change the Drillthrough row limit, on the Cube Analysis menu, click Options. On the Global page, type the desired number in the Maximum Rows box.

Tip: The data sheet created by the Drillthrough command is set up as an Excel list, so you can easily apply standard Excel features such as AutoFilter and PivotTable reports. 

What-If Analysis 
Analysis Services cubes are often thought of as purely reporting applications. A cube, however, can also function as the basis for a planning application. In a planning application, you make changes to values in the cube and see the ripple effect throughout the cube structure. In many ways, a what-if analysis is similar to using Excel formulas—you change the value in one cell and see the effect on formula in other cells. With a cube, however, the “formulas” are pre-defined as part of the structure of the cube. When you change the sales target for a single product, the cube calculates the effect on the grand total.

You can use what-if analysis on any cube, but in order to store the changes back to the server, the cube designer must write enable the cube. If you make what-if changes to a cube that is not write-enabled, the changes will all be lost when you close the connection to the cube.

The architecture of Analysis Services is such that write-back values are always stored at the most detailed level in the cube. Even if you were able to change the grand total for all products, Analysis Services would have to find a way to allocate that value down to the detail level before it could be stored. In order to make your experience with write-back as trouble-free as possible, the add-in only allows you to change values at the most detailed of the cube. A cube designer who is creating a cube for planning purposes should keep the cube relatively simple, with few dimensions, so that it is easy to get to the detailed level.

Tip: To get to the lowest level of a cube with several dimensions, add all the dimensions from the cube to the row, column or page filter areas. Select a single member of the lowest level of each of the page filter dimensions.
What-if Analysis is available for both structured and free-form reports. Here’s how to use what-if analysis: 

· Create a report layout that includes cells from the most detailed level of the cube. 

· On the Cube Analysis menu, point at What-If Analysis, and click Start. If the cube is not write-enabled on the server, you will get a warning message, and cells that you can modify will be colored yellow. If the cube is write-enabled, you will not get the warning message, and the modifiable cells will be colored green.  

· Type a new value into any yellow or green cell. 

· After making one or more changes, to see the ripple effect, you need to refresh the report. For a structured report, select any cell in the report, and on the Cube Analysis menu, click Refresh Report. For either type of report, you can refresh the connection or the worksheet.

· To discard your changes, on the Cube Analysis menu, point at What-If Analysis and click Cancel. If the cube is write-enabled, you can commit the changes back to the server. To do that, on the Cube Analysis menu, point at What-If Analysis and click Commit.

Technical Specifics

There are a number of technical considerations the Excel add-in has to allow for when building free-form reports. These technical considerations are reflected in the architecture that has been used for the Excel add-in

Architecture and Performance

The Excel add-in needs to allow for the support of Analysis Services members that do not have unique names.  Analysis Services allows you to have a region named West and also a sales representative named West. These are two members in different dimensions that happen to have the same name. You can even create two members of the same dimension with the same name—for example, two cities named Portland—from different states—or two months named January—from different years.

If the data provider required unique member names, a free form report would be relatively easy to create. You could type member names into cells and the add-in could unambiguously interpret the members. 
Providing the flexibility of to specify individual queries against Analysis Services data on a cell by cell basis is key attraction of free-form reporting. However, behind the scenes the treatment of the individual queries needs to be carefully handled so that the retrieval of the requested data is optimized in performance terms. To achieve this individual queries need to combined in to a single staging query while maintaining the links back to the original individual cell queries.

Add-In Components

In order to manage the unique names and the query consolidation, the add-in has several components that work behind the scenes:

· Cube Metadata Manager – Retrieves and shares OLAP cube information.

· Query Manager – Consolidates and executes queries and returns the results, and also performs write back to cubes.

· Report Builder User Interface – Builds reports using this "task pane" interface.

· Report Metadata Manager – Maintains report layout and enables report interactions such as isolate, eliminate, expand, collapse, drillup, and drilldown.

· Report Manager – Creates and manages formulas and presents query results in Excel cells.

The Excel Add-In will run only as many queries as are necessary to return data for all of the cells on the page. In essence, the Excel Add-In executes one or two queries in the background, and then populates each of the cells that contain add-in functions from the cached data in the background.
Deploying the Add-In

The Microsoft Excel Add-In for SQL Server Analysis Services is deployed as a Windows Installer package. It is compatible with Microsoft Office XP and Microsoft Office 2003. The installation file is less than 2MB. To download the add-in or find a list of frequently asked questions (FAQ), go to this location: http://www.microsoft.com/office/solutions/accelerators/exceladdin/default.mspx
After you install the add-in, you typically do not need to configure anything. You may, however, need to adjust the following Excel settings to make sure the add-in works most effectively:

· Set macro security to Medium. To do that, click the Tools menu, point at Macro, and click Security. On the Security Level tab, select Medium and click OK.

· Trust add-ins and Visual Basic projects. To do that, click the Tools menu, point at Macro, and click Security. On the Trusted Publishers tab, select both the checkboxes at the bottom, and click OK.

· Enable the add-in Excel functions. To do that, click the Tools menu, and click Add-Ins. From the list of available add-ins, select Functions Class, and click OK.

Distributing Reports

Because reports are stored in Excel workbooks, it is easy to share them with other users, but because the reports use an add-in and access an external data source, you must make certain preparations. The preparations you make will vary depending on whether you want to send static versions of the reports—so that others can see them without changing or refreshing them—or whether you want to send functioning reports. 

· If you want to send static reports, the easiest approach is to copy the values and formats to a new workbook. Select the entire worksheet (click the selection box at the top left of the worksheet, just above the first row heading). Copy the selected range. Create a new workbook. Select the entire worksheet (or cell A1), and paste the selected range. In the Paste Options drop-down that near the top right corner of the pasted range, select Values and Source Formatting. 

· If you want to send dynamic reports, the recipient must first install the Add-In. The recipient must also have access to the Analysis Server that contains the data, and permissions to access data. In addition, the first time you send a report that uses a particular connection, you must send the connection file along with the report. The connection file is stored in the Application Data\ORSLN folder for your user account. When you add a new connection file to the ORSLN folder, you need to exit and restart Excel for the add-in to detect the connection.

Tip: When sharing a workbook, include a .ZIP archive containing copies of any connection files used by the workbook. The recipients can then extract the connection files into the appropriate user account Application Data\ORSLN folder.

Add-in Excel Functions

The add-In includes seven Excel functions that can be used in spreadsheet cells or can be called from applications. Three of the functions support free-form reports, and four of the functions provide information about structured reports. To see the list of functions, in the Insert menu, click Function and then, from the Select a Category list, click ReportBuilderAddIn.Functions.

Free-form report functions

You can create a free-form report in three ways: by converting a structured report, by using the report builder, and by entering functions directly into a cell. If you are comfortable working with Excel functions, you can easily create or modify formulas that use add-in functions.

· CubeCellMember - This function takes two arguments: the name of a connection, and a text description of a member. The function registers the member internally, and returns the name of the member. For the connection argument, you use the name of the connection. For the dimension member name, you must include the dimension name, followed by a period, followed by something the add-in can interpret as a member. You can use a member key preceded by an ampersand (&), an official unique name, a member caption, or other options. With a connection that refers to the FoodMart 2000 Sales cube, all the following are legitimate dimension member arguments: “Product.&301”,  “[Product].[All Products].[Food].[Baking Goods]“, and “Product.BBB Best”.

· CubeCellValue - This function takes from 1 to 30 arguments. The first argument is the name of a connection. Each of the other arguments defines a single member that acts as a slicer. A slicer argument can either be a string constant, a reference to a cell that contains a string constant, or a reference to a cell that contains a CubeCellMember function. The rules for specifying a member are the same as in the CubeCellMember function. 

Note: Because Excel allows only 30 arguments in a function, the CubeCellValue function can include only 29 dimensions, which is far fewer than the 128 dimensions allowed in an Analysis Services 2000 cube. The only case where this could possibly become a problem is if you include dozens of page filters in the report.
· CubeCellProperty - This function takes three arguments:  the name of a connection, a member, and the name of a member property. The member has the same requirements as the slicer arguments in CubeCellValue. If the property doesn’t exist for the specified member, the function returns an error. 
Caution: Do not include any Excel functions in the same cells as any of the Add-in Functions. Because of the interaction between the Add-in and the Excel formula engine, such calculations may produce unpredictable results. For example, do not use Excel string functions to construct member names, or to multiply the result of two CubeCellValue functions. If you want to perform a calculation on the result of an add-in function, put the formula into a separate cell from the add-in function and reference the cell that contains the function.

Structured Report Functions
Four functions are available to extract metadata from structured report: StructuredReportGetName, StructuredReportGetConnectionName, StructuredReportGetMDX, and StructuredReportGetXML. You could use these functions, for example, to create an application that extracts the MDX query from a structured report and builds a Reporting Services report based on that query. These functions are read-only; you cannot store off report definitions and then assign them to a new structured report. 
· StructuredReportGetName - This function takes a cell reference and returns the internal Report ID for a structured report that includes the specified cell. The Report ID is used as an argument for the other functions. 
· StructuredReportGetConnectionName - This function takes the Report ID and returns the name of the connection file used by the report. 

· StructuredReportGetMDX - This function takes the Report ID, and returns the multidimensional expression (MDX) query used to query the Analysis Server. 
· StructuredReportGetXML - This function takes the Report ID, and returns an XML structure that includes all the information used to create the report, including the MDX query and all the report and global options.  A support organization could use this information to trouble-shoot unexpected behavior with a report.

· An end user would probably never use any of the structured report functions.

PivotTable Reports and the Excel Add-in

The add-in is designed to complement rather than replace the PivotTable reports included as part of Excel and the Office Web Components. The following lists summarize key similarities and differences between PivotTable reports and the Excel add-in. This is not new information, but recaps information already presented.
Functionality shared with PivotTable reports

Many of the features included in the add-in are basic capabilities and are also available in PivotTable reports. The implementation may vary somewhat between the different tools, but the functionality is basically available.

· Create page filters that filter the data in a report (slice)

· Group data values by members on rows and columns (dice)

· Nest members from multiple dimensions on a single axis

· Add Excel formatting and formulas to a report

· Pivot a dimension from one axis to another (structured reports only)
· Display member property values (free-form reports only)
PivotTable report functionality not available in the add-in

Some functionality that is available in PivotTable reports is not available in either structured or free-form reports in the add-in. 

· Automatic integration with PivotChart reports

· Automatic display of “Percent of Column” and similar calculations

· Multi-select for page filters
· Separate columns for each level of a hierarchy

· Add only selected levels from a hierarchy to a report

· Automatically display default member of a dimension

· Apply different formats to different levels of a hierarchy
Add-in functionality not in PivotTable reports

Some functionality is available through the add-in that is not available in PivotTable reports.

· Enhanced member selection, including the ability to search

· Multiple hierarchy levels in a single report column
· Out-of-box support for extended cube operations such as Drillthrough, write-back, actions, and server formatting

· Custom expressions for determining the set of members to display, including text comparisons and top and bottom rankings (structured reports only)
· Extended navigation options, including drill up, drill down, expand, collapse, isolate, and collapse (some options in structured reports only)
· Integrate data from different cubes, different databases, or different servers (free-form reports only)
· Create asymmetrical reports, where values from multiple dimensions are on a single axis (free-form reports only)
· Insert Excel formulas into the middle of data retrieved from the cube and have the formulas automatically replicate as you expand dimension members (free-form reports only)
Conclusion

The Microsoft Excel Add-in for SQL Server Analysis Services provides versatile and easy-to-use browsing and reporting capabilities in the familiar and feature-rich Microsoft Excel environment.

The complementary design of structured and free-form report types gives you the power to quickly analyze and navigate your data, and then convert the layout into a free-form report that you can continue to explore, with the added flexibility of rearranging data into any desired configuration, and combining multiple data sources into a single report.

The Add-in architecture provides excellent query performance, even with the multiple formulas of a free-form report. 
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Steve Springer


Senior Finance Manager


Microsoft Corporation











[image: image2.png]
PAGE  

_928582940.doc
[image: image1.png]






